Table of Contents

Introduction .............................................................................................................................................. 3
IEEE 1735-2014 Standards for IP and EDA Vendors ....................................................................................... 3
Encryption Algorithms ............................................................................................................................................... 3
Encryption Envelopes ............................................................................................................................................... 5
Decryption Envelopes ............................................................................................................................................... 6

1 Securing Your IP Core ............................................................................................................................. 8
Public Key from EDA Vendors .................................................................................................................................. 9
Adding an Encryption Envelope to Your RTL ......................................................................................................... 11
encryptP1735.pl Script ........................................................................................................................................... 13
Packaging and Bundling the Encrypted IP and the Data Key ................................................................................. 16

2 Running Libero SoC with Encrypted IP ................................................................................................. 17
Encrypted IP Design Flow Must Use a Verilog Netlist from Synthesis ........................................................... 18
Import Encrypted IP Core as HDL .......................................................................................................................... 19
Run Synthesis ........................................................................................................................................................ 20
Run ModelSim Simulation ...................................................................................................................................... 22
Libero SoC and Encrypted IPs .................................................................................................................................. 22
Frequently Asked Questions .................................................................................................................................. 26

A Product Support ..................................................................................................................................... 27
Customer Service ............................................................................................................................................... 27
Customer Technical Support Center ...................................................................................................................... 27
Technical Support ............................................................................................................................................... 27
Website .................................................................................................................................................................. 27
Contacting the Customer Technical Support Center .............................................................................................. 27
ITAR Technical Support ......................................................................................................................................... 28
Introduction

Microsemi adopted IEEE 1735-2014 and supports an encrypted IP design flow for the SmartFusion2, IGLOO2, RTG4, and PolarFire silicon families.

See "Securing Your IP Core" on page 8 to get started securing your IP core.

See "Running Libero SoC with Encrypted IP" on page 17 for information on running Libero SoC with encrypted IP.

Together with its OEM tools, Synplify Pro from Synopsys (Synplify Pro ME I2013.09MSP1 or later) and ModelSim (ModelSim 10.2c or later) from Mentor Graphics (both of which support IEEE 1735-2014), Libero SoC (v11.3 or later) enables a seamless design flow for designers targeting SmartFusion2, IGLOO2, RTG4, and PolarFire when they use encrypted IP cores in their design.

Use of IP cores not only shortens the design cycle time but also provides proven and reliable design components for re-use in multiple applications. Using an IP core in the EDA design flow involves two conflicting considerations that must be resolved: IP security and IP interoperability across different EDA tools.

Libero SoC Secure IP Design Flow Requirements

Table 1 lists the software and hardware requirements for Designing with Secure IPs in Libero SoC.

<table>
<thead>
<tr>
<th>Design Requirements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>SmartFusion2 / IGLOO2 Family devices</td>
<td>This feature is supported for SmartFusion2 / IGLOO2 family devices.</td>
</tr>
<tr>
<td>Host PC or Laptop</td>
<td>Windows 64-bit Operating System / Linux 64-bit Operating System.</td>
</tr>
<tr>
<td><strong>Software Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>Libero System-on-Chip (SoC)</td>
<td>v11.3 or Later</td>
</tr>
<tr>
<td>Synplify Version</td>
<td>Synplify Pro ME I2013.09MSP1 or later</td>
</tr>
<tr>
<td>ModelSim Version</td>
<td>ModelSim 10.2c or later</td>
</tr>
<tr>
<td><strong>Encryption Script Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>OpenSSL</td>
<td>Most Linux and Cygwin have OpenSSL pre-installed. Provide OpenSSL installation location in “PATH” environment variable of system.</td>
</tr>
<tr>
<td>Perl</td>
<td>Any version of Perl with following packages installed: FindBin, Math, Getopt, File, MIME</td>
</tr>
<tr>
<td>Cygwin (for Windows OS)</td>
<td>For executing Perl Script on Windows OS</td>
</tr>
<tr>
<td>Public Keys for encryption</td>
<td>Provided on request</td>
</tr>
</tbody>
</table>

IP Security and IP Interoperability Across Design Tools

Use of IP cores not only shortens the design cycle time but also provides proven and reliable design components for re-use in multiple applications. Using an IP core in the EDA design flow involves two conflicting considerations that must be resolved: IP security and IP interoperability across different EDA tools.

IEEE 1735-2014 Standards for IP and EDA Vendors

IEEE 1735-2014 is an encryption scheme proposal adopted by most IP and EDA vendors to ensure the interoperability of IP cores among the IP vendors and EDA tools. The objective of IEEE 1735-2014 is to serve the IP vendors and the EDA community in the following ways:

- For the IP vendor, protect the security of the IP core in the design flow across different EDA tools.
- For the IP core users and EDA tool vendors, ensure the interoperability of the IP core across different EDA tools.

Encryption Algorithms
Libero SoC supports the following encryption algorithms:

- des-cbc
- 3des-cbc
- aes128-cbc
- aes256-cbc

There are two major classes of encryption methodologies: Symmetric and Asymmetric.

**Symmetric Encryption**

This encryption scheme uses a special string as a key to encrypt the data. The same key is used to decrypt the data (Figure 1). Examples of this type of encryption algorithms include:

- Data Encryption Standard (DES), such as des-cbc.
- Triple DES or TDES or TDEA (Triple Data Encryption Algorithm) which uses the DES algorithm three times, such as 3des-cbc.
- Advanced Encryption Standard (AES), such as aes128-cbc and aes256-cbc.
Asymmetric Encryption
This encryption scheme uses two different keys: one for encryption and another for decryption. The end user generates two keys, one public and one private. The end user distributes the public key to whoever needs it for encryption and keeps the private key to use for decryption (Figure 2).

Common examples of asymmetric encryption algorithms are:
- DH (Diffie-Hellman)
- RSA (Rivest, Shamir, and Adelman).

Two Levels of Encryption
There are two levels of encryption when producing an encrypted IP core. First, the IP core vendor uses a session (random) key to encrypt the IP content. This is the first level of encryption (Figure 1). Then the IP core vendor uses the Public Keys from EDA vendors to encrypt the session key. This is the second level of encryption (Figure 2).

A Public Key must be provided for each EDA tool to the IP core vendor. For Libero SoC customers who use third-party IP’s in their design, the EDA vendors are:
- Synopsys for Synplify Pro
- Mentor Graphics for ModelSim
- Microsemi for Libero SoC

The result of the first level of encryption is the encrypted data block. The Random session key required for symmetric encryption of the data block is generated by the encryptP1735.pl script.

---

**Figure 1** • Data Encryption of Source Data IP
The result of the second level of encryption is the encrypted session key.

---

**Figure 2** • Session Key Encryption
Encryption Envelopes

The encryption envelope is the preamble to the IP in the HDL file. The IP core vendor must prepare an encryption envelope for all EDA tools which are intended to be used with the IP. The encryption envelope consists of pragma keywords (see "Pragma Keywords" on page 12) that provide the following information:

- Encryption Version
- Encoding Type
- Encryption Agent
- Key Owner
- Key Name
- Key Method

An example of an Encryption Envelope appears below. Note that the encryption envelope identifies three EDA tool vendors/key owners.

```vhdl
module secret (a, b, sum, clk, rstn);
input[7:0]a, b;
input clk, rstn;
output[8:0]sum;
reg[8:0]sum;

`pragma protect version=1
`pragma protect encoding=(enctype="base64")
`pragma protect author="author-a", author_info="author-a-details"
`pragma protect encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption scripts"
`pragma protect key_keyowner="Synplicity",key_keyname="SYNP05_001",key_method="rsa",key_block
`pragma protect key_keyowner="Mentor Graphics Corporation",key_keyname="MGC-VERIF-SIM-RSA-1",key_method="rsa",key_block
`pragma protect key_keyowner="Microsemi Corporation",key_keyname="MSC-IP-KEY-RSA",key_method="rsa",key_block
`pragma protect data_keyowner="ip-vendor-a", data_keyname="fpga-ip", data_method="aes128-cbc"
`pragma protect begin
always @(posedge clk or negedge rstn) begin
if (!rstn)
    sum <= 9'jb0;
else
    sum <= a + b;
end
`pragma protect end
endmodule
```
Decryption Envelopes

The Decryption Envelope is the preamble to the encrypted IP. The Decryption Envelope consists of pragma keywords (see "Pragma Keywords" on page 12) that provide the following information:

- Encryption Version
- Encoding Type
- Encryption Agent
- Key Owner
- Key Name
- Key Method

A Verilog example of the Decryption Envelope appears below.

```verilog
module secret (a, b, sum, clk, rstn);
input[7:0]a, b;
input clk, rstn;
output[8:0]sum;
reg[8:0]sum;

//Decryption Envelope begins
`pragma protect begin_protected
`pragma protect version=1
`pragma protect author="author-a", author_info="author-a-details"
`pragma protect encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption scripts"
`pragma protect key_keyowner="Synplicity", key_keyname="SYNP05_001", key_method="rsa"
`pragma protect encoding=(enctype="base64", line_length=76, bytes=256)
`pragma protect key_block
N8WFgMwaABDJQ+aQ+a+1+BDxDTnwq7K04UG00S27KzF4jtejZxAewyFi9FsQmRn7RTnxu7Ifw
lmZ2yG6yW7M8Aq2ePbbrQbQRLaL8NF4/110FUXQxNwDxRZxctgVHVL0sFxPxd25W5yNeQWnkTekA2ln
ubK1DFNgY5xS5xvw3b0EZMMPjhpmp2lcvRljlE3uOAAQZLbEZCBj51KwH22hUKlRzX34+9p6b
tvZxhB/UlTbsxXvdPczW2JItaAXFwSN5D75zAviq7ACIaWVeW87/n2M8hSD5Vcmz7n9Rg3JARQ0Fee2pd
usuhdCFJm1YewoZyFReV7rJczbY48d3LPtoa==
`pragma protect end_protected

//Decryption Envelope ends
```
```
pragma protect data_keyowner="ip-vendor-a", data_keyname="fpga-ip",
data_method="aes128-cbc"
// Decryption Envelope ends
pragma protect data_block
RgKC71ha7zh3MLd50RYzZoCwPWFeyLwISIXDLkpL6qFfm1wzEwFvZjNfQCNUg0SHeIRpxg9i
lXnvMiBjqCiQ1Vwp32UtfsX625K8+yvJLMFdhQ8o/2qxa6V1aHbHrsSU10XGskRmu3JvNuNfAk
0IoBiHhFEJ0Vu6VE1g=

pragma protect end_protected
endmodule
1 – Securing Your IP Core

As an IP vendor, you must protect your Intellectual Property and package your IP core such that it is inter-operable with EDA tools without compromising security. Encryption is managed on two levels (Figure 1-1):

• IP Core Encryption
• Data Key Encryption

To encrypt an IP core with the IEEE 1735-2014 scheme:

1. Obtain the Public Key (see "Public Key from EDA Vendors" on page 9) from each downstream EDA tool vendor.

2. Add the Encryption Envelopes (see "Encryption Envelopes" on page 5) to the RTL code. Ensure that all required EDA tool vendors are included.
3. Execute the encryptP1735 Perl Script.

### Encryption Steps (IP Vendor)

- **Unencrypted Source Data (IP)**
  - Encrypt with IP Vendor’s Symmetric Data Key
    - Symmetrically Encrypted Data Block
    - Bundle Data Block and Key Blocks in One File
    - Hand Off to IP End-User or Downstream EDA Vendor

- **EDA Vendor’s Public Key**
  - Encrypt Data Key with EDA Vendor’s Public Key
    - Asymmetrically Encrypted Key Block

---

**Figure 1-1 • IP Encryption**

### Public Key from EDA Vendors

Obtain a Public Key from each downstream EDA tool vendor. Aggregate the Public Keys from the vendors into a single Public Keys Repository File. An example of the file is shown below.

**Note:** The keys shown below are dummy keys and will not work. To request the public key file that contains all 3 public keys along with the Perl script to encrypt your files, please email soc_marketing@microsemi.com.
`pragma protect key_keyowner="Synplicity", key_keyname="SYNP05_001", key_public_key
-----BEGIN PUBLIC KEY-----
MIIBIjANBgkqhkiG9w0BAQEFAAOCAQ8AMIIBCgKCAQEAybsQaMidiCHZyh14wbXnUp8fKk+Jv5LoPgqDf5Srf5MX5XbYp0WF1d32onXEPkxwELKL4Rg54340FgQ2I0l
irdimKRhntuPkrxJzBmr7WYzGK7wLX7S3Ee/1EwqK90uK7?cMNencLyc15yX4f/KQ9g
WS5nLD-Nh6BL7w0RvSevePC1fOkau1u7b7Mwb1mcqCLBRbP9/eFw0UoxVRzjA
+pJvORwhYzENhwvTb1bhJsnynReT1LfdF/D5WzoiktQ/0KB1IP7QHms5vByvDMa77g
6axKKB9zh2DpVlojds1Y5ywXxEXOA93nfJnLsJq3i/P01v5TmtnCY3Kwryw4B
eQfDQAB-----END PUBLIC KEY-----`

`pragma protect key_keyowner="Mentor Graphics Corporation", key_keyname="MGC-VERIF-
SIM-RSA-1", key_public_key
-----BEGIN PUBLIC KEY-----
MIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQCnJfQb+LLzTMX3NRRasv7A8+LV
5SgeMEJcvf9Tf2em4i240qtp8E+nx7QFzoctC1ClC6ocq2q1vEJcpq9TTD+tm6jer
JSJ+R44xxCgvtHYUrWt08x0Qq9rguyGwyX1RUnNBcJm34ZULeYxRz8720j6r9Qn5e
1kda/eBcszMlyOoCgQIQAQAB-----END PUBLIC KEY-----`

`pragma protect key_keyowner="Microsemi Corporation", key_keyname="MSC-IP-KEY-
RSA", key_public_key
-----BEGIN PUBLIC KEY-----
MID4A1NBgkghki19gw0QBAEQFAAOCABA8AMIIIdyqKCABEAxvORTH+30oRtdosoq0Q7e
3LqSbhhjfcudafujknm+21ui8s9cvxjkaYKRDdasklq1kDGTyFiYUIKaeKv3Wv
xba1lfttt121BDdDf/D0V3s3LYKxkSقف/0/31zR5FAZ8cyu0PXyoiHQ/fgp0wluo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-----END PUBLIC KEY-----`
Adding an Encryption Envelope to Your RTL

You must add the Encryption Envelopes (see "Encryption Envelopes" on page 5) to the RTL codes. All EDA tools that need access to the encrypted data block must be included and identified as a key owner in the Encryption Envelope.

An example of a Verilog IP core and a VHDL IP core with an Encryption Envelope is provided below. The envelope identifies Microsemi, Synopsys and Mentor Graphics as key owners.

Verilog IP Core with Encryption Envelope

```
module secret (a, b, sum, clk, rstn);
input[7:0]a, b;
input clk, rstn;
output[8:0]sum;
reg[8:0]sum;

/*Encryption Envelope*/
`pragma protect version=1
`pragma protect encoding=(enctype="base64")
`pragma protect author="author-a", author_info="author-a-details"
`pragma protect encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption scripts"
`pragma protect
key_keyowner="Synplicity",key_keyname="SYNP05_001",key_method="rsa",key_block
`pragma protect key_keyowner="Mentor Graphics Corporation",key_keyname="MGC-VERIF-SIM-RSA-1",key_method="rsa",key_block
`pragma protect key_keyowner="Microsemi Corporation",key_keyname="MSC-IP-KEY-RSA",key_method="rsa",key_block
`pragma protect data_keyowner="ip-vendor-a", data_keyname="fpga-ip", data_method="aes128-cbc"
/*Ends Encryption Envelope*/
`pragma protect begin
always @(posedge clk or negedge rstn) begin
if (!rstn)
    sum <= 9'b0;
else
    sum <= a + b;
end
`pragma protect end
endmodule
```

VHDL IP Core with Encryption Envelope

```
library ieee;
use ieee.std_logic_1164.all;
use ieee.std_logic_unsigned.all;

entity counter is
    generic(n: natural :=2);
    port(clock:in std_logic;
         clear:in std_logic;
         count:in std_logic;
         Q:out std_logic_vector(n-1 downto 0)
    );
end counter;

architecture behv of counter is
```
signal Pre_Q: std_logic_vector(n-1 downto 0);

begin

'protect version=1
'protect encoding={enctype="base64"}
'protect author="author-a", author_info="author-a-details"
'protect encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption scripts"
'protect key_keyowner="Synplicity", key_keyname="SYNP05_001", key_method="rsa", key_block
'protect key_keyowner="Mentor Graphics Corporation",key_keyname="MGC-VERIF-SIM-RSA-1",key_method="rsa",key_block
'protect key_keyowner="Microsemi Corporation", key_keyname="MSC-IP-KEY-RSA", key_method="rsa", key_block
'protect data_keyowner="ip-vendor-a", data_keyname="fpga-ip", data_method="aes128-cbc"
'protect begin

  process(clock, count, clear)
  begin
    if clear = '1' then
      Pre_Q <= Pre_Q - Pre_Q;
    elsif (clock='1' and clock'event) then
      if count = '1' then
        Pre_Q <= Pre_Q + 1;
      end if;
    end if;
  end process;

  Q <= Pre_Q;

'protect end
end behv;

Pragma Keywords

Table 1-1 describes the Pragma keywords in the Encryption Envelope.

<table>
<thead>
<tr>
<th>Pragma Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>begin</td>
<td>Opens a new encryption envelope</td>
</tr>
<tr>
<td>end</td>
<td>Closes an encryption envelope</td>
</tr>
<tr>
<td>begin_protected</td>
<td>Opens a new decryption envelope</td>
</tr>
<tr>
<td>end_protected</td>
<td>Closes a decryption envelope</td>
</tr>
<tr>
<td>author</td>
<td>Identifies the author of an envelope</td>
</tr>
<tr>
<td>author_info</td>
<td>Specifies additional author information</td>
</tr>
<tr>
<td>encoding</td>
<td>Specifies the coding scheme for the encrypted data</td>
</tr>
<tr>
<td>data_keyowner</td>
<td>Identifies the owner of the data encryption key</td>
</tr>
<tr>
<td>data_method</td>
<td>Identifies the data encryption algorithm</td>
</tr>
<tr>
<td>data_keyname</td>
<td>Specifies the name of the data encryption key</td>
</tr>
</tbody>
</table>
Table 1-1 • Pragma Keywords (continued)

<table>
<thead>
<tr>
<th>Pragma Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>data_public_key</td>
<td>Specifies the public key for data encryption</td>
</tr>
<tr>
<td>data_decrypt_key</td>
<td>Specifies the data session key</td>
</tr>
<tr>
<td>key_keyowner</td>
<td>Identifies the owner of the key encryption key</td>
</tr>
<tr>
<td>key_method</td>
<td>Specifies the key encryption algorithm</td>
</tr>
<tr>
<td>key_keyname</td>
<td>Specifies the name of the key encryption key</td>
</tr>
<tr>
<td>key_public_key</td>
<td>Specifies the public key for key encryption</td>
</tr>
<tr>
<td>key_block</td>
<td>Begins an encoded block of key data</td>
</tr>
<tr>
<td>version</td>
<td>P1735 encryption version</td>
</tr>
</tbody>
</table>

encryptP1735.pl Script

Execute the encryptP1735.pl script to encrypt your IP. The encryptP1735 script is a Perl script that Synopsys makes available to IP vendors for encryption of their IP cores.

**Note:** Before running the script, make sure that Open SSL is installed on your machine. Open SSL is required for the script to work.

**Note:** For Windows OS, it is recommended that the script be executed in the Cygwin Environment on Windows.

The example command below invokes the script with a random key to encrypt the data block:

```
perl./encryptP1735.pl -input secret.v -output secret_enc.v -pk public_keys.txt -v -om encrypted
```

where

<table>
<thead>
<tr>
<th>-input secret.v</th>
<th>Specifies secret.v as the input file to the script; the input file is the non-encrypted HDL file containing one or more encryption envelopes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>-output secret_enc.v</td>
<td>Specifies secret_enc.v as the name of the encrypted output file after running the encryption script.</td>
</tr>
<tr>
<td>-pk public_keys.txt</td>
<td>Specifies public_keys.txt as the public keys repository file. This file contains public keys for all downstream EDA tools. The public keys file must include public keys for all EDA vendors mentioned in the encryption envelope.</td>
</tr>
<tr>
<td>-om encrypted</td>
<td>Specifies how the IP is treated when generating the synthesis netlist; encrypted is the default mode. In this mode, the same data key used for encryption of the IP is used in the output synthesis netlist.</td>
</tr>
<tr>
<td>-v</td>
<td>Specifies the script runs in verbose mode</td>
</tr>
</tbody>
</table>
Output Encrypted File

The output file generated by the script contains pragma directives for decrypting the encrypted data (IP core) and the data key used to encrypt the data. The example below shows a Verilog and a VHDL of the output.

Output Encrypted Verilog

```verilog
module secret (a, b, sum, clk, rstn);
input[7:0]a, b;
input clk, rstn;
output[8:0]sum;
reg[8:0]sum
`pragma protect begin_protected
`pragma protect version=1
`pragma protect author="author-a", author_info="author-a-details"
`pragma protect encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption script"
`pragma protect key_keyowner="Synplicity", key_keyname="SYNP05_001", key_method="rsa"
`pragma protect encoding=(enctype="base64", line_length=76, bytes=256)
`pragma protect key_block
Synopsys Key Block
NfR8W3gmzw3h38J4qA+q+1Bh5CD7zqVKn0U500S7KzF4jtejZxBawxyPaShFsbQn9rTnxu71w
lm28yd6yN7MqAx2ePgrabqCblRSA8XF/i1UFUXQXnWdZrxtgcVHLoF8Pxxpd5Wxw4wWQKTeaAln
uhXfDfnYsaxp5M3oZ2E0PMLqfHmpz2clvJ1E3u0OAQQJlECEB9j1kMz2hhk1KxR2x34+9p68
tvzbMu/ultFksxvDcN23ultAvNFSH5ND75zAviq7ACIAvH87/m2RahSDSVcmz7nDMPs3JQ0PE2pd
usuhCdfCuM1yAeCzyqFev7RjCzbvY483LPTca=

`pragma protect key_keyowner="Mentor Graphics Corporation", key_keyname="MGC-VERIF-SIM-RSA-1", key_method="rsa"
`pragma protect encoding=(enctype="base64", line_length=76, bytes=128)
`pragma protect key_block
Mentor Graphics Key Block
boN+vsIs0J/Ihy7BF0MWz2daey12zoeapFP9Vx0DvN1M3qSglqZgfJptMFtQDGwbwhee7Nqmg0UGVw
WbqgE0W/UVWYaWj1i64f1sqgKfu7kFcbMhLLbU0WHUVFQjRhdqgEBWKM390OSYtJnLhGPa08
R2gdcWOFvZ4IEAUXq40=

`pragma protect key_keyowner="Microsemi Corporation", key_keyname="MSC-IP-KEY-RSA", key_method="rsa"
`pragma protect encoding=(enctype="base64", line_length=76, bytes=960)
`pragma protect key_block
Microsemi Key Block
MII[d4JANBkgqkhiG9w0BAQEFAQAOA88AM1LdyKC9A8AxvOR7+3o0ortdOgobQ7e
3LQ5BhfcudaFujkjinm=213ul89cvxjkaYKDadsklgfK1GTFyYUIIaRsKv3MW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qsBSB5Rykji0v70Aav97A0AERBVjykjlWVYKLJMJiuVweeRPGWitKdeEXHONSFR
10EkLJigEsAx0W2ZEvCQa5f1P5+46+sdjDOrWY8wKX29Vx6Qq9f89Yq78PiIUYECt+Yt
y8y8D7tpjd3p+Koa88tCdFkv8HET1v8q0DmHeuet1XzGFOHr0msfC9FETew56NdDp
B3J7ayakWqh7+t+7a346gymWZeaBtTkImn6uX0YJ320fksfjxy3kJlaqv1DZ
10pILJQMXCQaUoaJlP BuPvWAGEBBE4R3MNQpZ9w7G1m6KRN3NNbnb6qFyMq2uS
6AowT3AVFhr6R0ynjIELJ3k3t/OS/YbA6w6FPG0GdnNRAgMBAAE=

`pragma protect data_keyowner="ip-vendor-a", data_keyname="fpga-ip", data_method="aes128-cbc"
`pragma protect encoding=(enctype="base64", line_length=76, bytes=128)
`pragma protect data_block
`pragma protect data_block
RgRCC714hx7h33MLdSS0YrzoCwWFVEyLwISIXDLkpL6qFgPcM1mWZExFWZjNFQCNUGoSHc1Rpx9g1
```
library ieee;
use ieee.std_logic_1164.all;
use ieee.std_logic_unsigned.all;

entity counter is
  generic(n: natural :=2);
  port(clock:in std_logic;
       clear:in std_logic;
       count:in std_logic;
       Q:out std_logic_vector(n-1 downto 0)
   );
end counter;

architecture behv of counter is
begin
  signal Pre_Q: std_logic_vector(n-1 downto 0);
begin
  `pragma protect begin_protected
  `pragma version=1
  `pragma author="author-a", author_info="author-a-details"
  `pragma encrypt_agent="encryptP1735.pl", encrypt_agent_info="Synplify encryption scripts"
  `pragma encoding=(enctype="base64", line_length=76, bytes=256)

  `pragma key_keyowner="Synplicity", key_keyname="SYNP05_001", key_method="rsa"
  `pragma key_encoding=(enctype="base64", line_length=76, bytes=128)

  `pragma key_block
  EzupxwpLxigCoy7o42J4oTvJEXDsePHIEXYIfyKVXIs8/6incqBuPuWZ6osQcaegOtanunB71Po
  stFj1ZLgsLDeL517j8cxhys0ky/8TkZCq7q0s5MbfeFAMFtIOajjGT4Ab29DdosbC6QKNY
  FCVU6ySh5Nrame6b8znTjCv416exzcHTJVstJycrzcVkvFV1RY+BBtcXhBrxCZSzu9W0Hh00ucufC
  jkaHE//kfFidij1jjjijdudnJ5roGt3BD6FQ7f/CfL6H91kqikEfsy2g0k4k21N0F656h2MKCj405
  ye7d1aHqH3FmTnGnY95f7Mc2O1t04Z1qCQ==
  `pragma key_keyowner="Mentor Graphics Corporation", key_keyname="MGc-VERIF-SIM-RSA-1",
  key_method="rsa"
  `pragma key_encoding=(enctype="base64", line_length=76, bytes=960)

  `pragma key_block
  Pfy8Cgmz1tqEGsqgKQ/<HHByVzqO7IZq9W5lfEgti2EYsKVTU974UChJeOjwTJU4s24glg12QF31
  SYQ6eNq8G84V+DMh9a3b1k9UDh4KJq5xrs6Qwv6co3rZ09b2NPL8w9uaGpaK4P0DnqXnqyB0Y0T6W
  pDdw9u4pvhI72Lt5ey=
  `pragma key_keyowner="Microsemi Corporation", key_keyname="MSC-IP-KEY-RSA",
  key_method="rsa"
  `pragma key_encoding=(enctype="base64", line_length=76, bytes=960)

  `pragma key_block
  MjID4jANBkgkx1199wUBAQPEFAAOCX88AAM1DyqKCA8EAvwOR7+300rtdogobQ7e
  3LqS0Bhfcudafqfjimn+12u189cvxjkaYWRA2sdlkgfklDqfYUIYKzF5xYmrW
  xba1lfft121B8B7/D5D83MLYKwAge20/SaZ4TF2R8cyuUPxYov1HD/7qGkUwao
  U/3Spnvr76K/F014X567/xbB/x2v9zvzn3ghfqcEu8Dn8OpWNY4fSg4g9vQF
  hmv71Hj01NRvwJhxYnxCeWlWPOjzru+81jJHx/B/9ChKkTvBP6vkV//IX50d1O
Packaging and Bundling the Encrypted IP and the Data Key

When you execute the encryptP1735.pl script, you bundle and package the Encrypted IP and the Encrypted Data Key together in one single file, which is the output of the script. This file is ready for delivery to your customers.
Libero System-on-Chip (SoC) software v11.3 or later supports the use of third-party encrypted IP cores in the design flow for SmartFusion2, IGLOO2, RTG4, and PolarFire families (Figure 2-1).

To run Libero SoC with Encrypted IP:
Libero SoC software support for encrypted IP is enabled by default. Follow the steps below to incorporate an encrypted IP inside the Libero software.

1. Set your Project Settings so that the synthesized output is a Verilog netlist.
2. Import the encrypted IP core as HDL (page 19).
3. Run synthesis (page 20) and simulation (page 22).
4. Run the rest of the Libero SoC design flow as shown in Figure 2-1.

Figure 2-1 • Encrypted IP Design Flow
Encrypted IP Design Flow Must Use a Verilog Netlist from Synthesis

When creating a new project, you must change Project Settings to support the IEEE 1735-2014 secure IP flow. You can then import the encrypted IP core as Verilog or VHDL source files.

The IEEE 1735-2014 scheme supports only Verilog as the netlist format; EDIF format is not supported. You must set Libero SoC Project Settings to use the Verilog netlist from Synthesis.

1. From the Project menu, choose Project Settings > Design Flow.
2. Select Verilog Netlist as the Synthesis Gate Level Netlist format (Figure 2-2).
3. Click Save and then Close.

Figure 2-2 • Project Settings
Import Encrypted IP Core as HDL

Import the encrypted IP HDL and the non-encrypted HDL file as HDL source files (File > Import > HDL Source Files). The Design Hierarchy displays the imported file in your design (Figure 2-3).

Note: It is recommended that the encrypted IP be presented as a single file. If the IP is currently organized in a hierarchy of files, it is recommended that the entire IP be concatenated into a single file after encryption. Currently, if the encrypted IP is defined in multiple files, the user needs to pass the (lower level) files manually to synthesis & RTL simulation steps. This is done from Organize input file option Synthesis / Simulation tool, as shown below. Refer to Organize Source file in Libero Help for more information on how to organize source files.

Figure 2-4 shows how to organize input source files for Synthesis.

Smart Design Support

SmartDesign is a visual block-based design creation tool for instantiation, configuration and connection of Microsemi IP, user-generated IP, custom/glue-logic HDL modules. Encrypted IP can also be instantiated in a SmartDesign, along with other non-encrypted IP. Refer to About SmartDesign in Libero Help for more information.
Run Synthesis

After synthesis, only the interface signals (inputs and output ports) of the Secure IP core are visible in the RTL and Technology views (Figure 2-5 and Figure 2-6). Signals and instance names internal to the Encrypted IP are not visible.

Figure 2-5 • SynplifyPro RTL View
In the RTL and Technology Views, the push and pop commands are disabled for design blocks encrypted with IEEE 1735-2014. You cannot push into the encrypted IP block 'U0' to look at the internal signals, nets or instances inside the encrypted block.
Run ModelSim Simulation

ModelSim simulates the entire design for pre-synthesis, post-synthesis and post-layout simulations. However, the signals and instances internal to the encrypted IP are not exposed and are not available for debug.

The values of the internal signals are not displayed in the waveform window; only the interface signals at the boundary of the encrypted IP instance ‘U0’ are displayed (Figure 2-7).

---

**Figure 2-7 • Modelsim Simulation of Encrypted IP Core**

Note: Simulation is supported for both Verilog and VHDL.

Libero SoC and Encrypted IPs

Libero SoC Software processes designs with encrypted IP through the entire Design without compromising the encrypted IP content. The encryption of IP is protected in Synthesis and Simulation tools, as mentioned in earlier sections.

All netlists exported from Libero SoC have the IP component encrypted. These include:

- Back annotated netlist after Place and Route: *_ba.v or *_ba.vhd
- Exported netlist after compile: *.v or *.vhd

Microsemi adheres to the Encryption Guidelines in the IEEE 1735-2014 standard throughout the design flow.

Example

This section shows an example in which an Encrypted Module is implemented using the Libero SoC Secure IP Flow.

The example consists of the following files:

- **Secret.v**: This is a simple Non-Encrypted Verilog module. This module has encryption envelopes as mentioned on page 5.
Secret_enc.v:- This is the encrypted version of Secret.v module which has been encrypted by executing encryptP1735.pl script on Secret.v module.
Top.v:- This is a top level module instantiating encrypted secret_enc.v module.
Tb.v:- Test Bench for Top.v module.
Public_keys.txt:- This is Text File containing Public Keys from Synopsys, Mentor and Microsemi as mentioned on page 9.

**Encryption of IP Module**

We are going to use to encryptP1735.pl script which implements IEEE 1735-2014 standard for encryption of IP Module (secret.v in this example). The segment of the code that needs to be encrypted have to be included within Encryption Envelopes. (Refer to "Adding an Encryption Envelope to Your RTL" on page 11).

All Public Keys from vendors supporting this standard are stored in a single file Public_Keys.txt. Execute encryptP1735.pl script with the secret.v as input file and secret_enc.v as output file. Figure 2-8 shows an example of output after encryptP1735.pl has been executed on the secret.v module.

![Figure 2-8 • Output of EncryptP1735.pl script](image)

The output file is similar to "Output Encrypted Verilog" on page 14.
Observe that the encrypted output source file of the IP have key_blocks corresponding to all the Vendors and Data_blocks with encrypted information.

**Note:** Refer to "encryptP1735.pl Script" on page 13 for more information about different parameters of the script. The script can be executed on both Windows and Linux OS with openSSL and Perl Installed.

**Importing Encrypted IP in Libero SoC**

Import an Encrypted module in the same way you import any HDL file into a Libero Project.

Create a Libero Project with SmartFusion2 / IGLOO2 / RTG4 / PolarFire family die. Import Top.v and Secret_enc.v files (File > Import > HDL Source Files) into the Libero Project. Also import the corresponding Test bench file tb.v (File > Import > HDL Stimulus Files). On importing these files, your design hierarchy and stimulus hierarchy appear as shown in Figure 2-9 and Figure 2-10.
There can be multiple instantiations of an encrypted module in a Top Level module or Smart Design. Select top.v as the Root module (Right-click > Set as Root). Change Synthesis netlist format to Verilog Netlist from the Libero Project Settings Menu (Project > Project Settings > Design Flow) as shown in Figure 2-11.
The Synthesis tool (Synplify Pro) decrypts the protected content using Synopsys Key Block present in Encrypted Module secret_enc.v. After synthesis, only the interface signals (inputs and output ports) of secure IP core are visible in the RTL and Technology views. Refer to “Run Synthesis” on page 20 for more information. The Verilog netlist file (.vm file) obtained after synthesis does not show internal instances of encrypted module and this information is again re-encrypted by synthesis tool.

Simulations

The Simulation tool (ModelSim) decrypts the protected content using the ModelSim Key Block present in Encrypted Module secret_enc.v. ModelSim simulates the entire design for pre-synthesis, post-synthesis and post-layout simulations. However, the signals and instances internal to the encrypted IP are not exposed and are not available for debug. Refer to “Run ModelSim Simulation” on page 22 for more information.

Compile and Layout

The rest of the tools in the Libero SoC Design Flow decrypt the protected content using Microsemi Key Block present in Encrypted Module secret_enc.v.

Once synthesis is completed, the Compile tool takes the encrypted .vm netlist file as input for further processing by the Layout Tool. The execution and output of these tools are similar to the Regular Flow.

**Note:** Constraints flow, including Timing Constraints and Floorplan Constraints, are not supported for instances inside encrypted Blocks. In the above example, Constraint flow is not supported for secret_enc.v module. However users can provide constraints to the interface of the encrypted module.

Generate Back Annotated Files

Once Layout is complete, users can generate the Back Annotated Files for Post-layout simulations. The *_ba.v or *_ba.vhd files generated shows the internal information of secure_enc.v module as encrypted. These file incorporate Key_Block from Mentor which is used for decryption while running Post-Layout Simulations.

Generate Programming Data

Once the design has completed Layout and Post-Layout Simulations, users can generate the Programming file.
Frequently Asked Questions

Below are some Frequently Asked Questions about Secure IP flow and its support in Libero SoC.

1. Are VHDL simulations supported, since we are using a Verilog Netlist?
   Secure IP flow is supported for both VHDL and Verilog. Mixed mode simulation is not required if the design and test bench are both in VHDL. The Verilog netlist is only required for passing the design from the synthesis to compile step in Libero. Post-synthesis and other simulation steps still use VHDL netlist if the Preferred input HDL type is VHDL at Project Creation.

2. Is Microsemi Block Flow supported in Secure IP Flow?
   No. Block Flow is not supported for Encrypt IP and Secure IP flow.

3. Are parameters/generics supported?
   Yes. Secure IP flow works on an Encrypted IP with parameters or generic definitions. However, leaving top level parameters/generics and ports unencrypted makes the RTL easier to integrate.
   Refer to the VHDL example in this document, which has a generic definition.

4. Which Versions of Perl and OpenSSL are required for encryptP1735.pl script?
   Any version of OpenSSL/Perl can be used for the script to execute.

5. Installing OpenSSL?
   OpenSSL is Open-Source Software. Most Linux Installations have OpenSSL pre-installed. Most Cygwin installations on Windows also have the OpenSSL Package, which can be installed.
   For Windows, you must install OpenSSL.exe.
   You can download a version of OpenSSL from https://code.google.com/p/openssl-for-windows/downloads/detail?name=openssl-0.9.8k_X64.zip. Once you install OpenSSL on Windows, you need to set the PATH Environment Variable to <openssl_installation_dir>\bin for the EncryptP1735.pl to work.

6. Can we import an encrypted Verilog core into a VHDL design, and vice versa?
   Yes. You can import an Encrypted Verilog (or VHDL) module in a VHDL (or Verilog) Design.
A – Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices. This appendix contains information about contacting Microsemi SoC Products Group and using these support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades, update information, order status, and authorization.

- From North America, call **800.262.1060**
- From the rest of the world, call **650.318.4460**
- Fax, from anywhere in the world, **650.318.8044**

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled engineers who can help answer your hardware, software, and design questions about Microsemi SoC Products. The Customer Technical Support Center spends a great deal of time creating application notes, answers to common design cycle questions, documentation of known issues, and various FAQs. So, before you contact us, please visit our online resources. It is very likely we have already answered your questions.

Technical Support


Website

You can browse a variety of technical and non-technical information on the Microsemi SoC Products Group home page, at [www.microsemi.com/soc](http://www.microsemi.com/soc).

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be contacted by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email, fax, or phone. Also, if you have design problems, you can email your design files to receive assistance. We constantly monitor the email account throughout the day. When sending your request to us, please be sure to include your full name, company name, and your contact information for efficient processing of your request.

The technical support email address is [soc_tech@microsemi.com](mailto:soc_tech@microsemi.com).
My Cases
Microsemi SoC Products Group customers may submit and track technical cases online by going to My Cases.

Outside the U.S.
Customers needing assistance outside the US time zones can either contact technical support via email (soc_tech@microsemi.com) or contact a local sales office. Visit About Us for sales office listings and corporate contacts.
Sales office listings can be found at www.microsemi.com/soc/company/contact/default.aspx.

ITAR Technical Support
For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms Regulations (ITAR), contact us via soc_tech_itar@microsemi.com. Alternatively, within My Cases, select Yes in the ITAR drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visit the ITAR web page.

About Microsemi
Microsemi Corporation (Nasdaq: MSCC) offers a comprehensive portfolio of semiconductor and system solutions for communications, defense & security, aerospace and industrial markets. Products include high-performance and radiation-hardened analog mixed-signal integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and synchronization devices and precise time solutions, setting the world's standard for time; voice processing devices; RF solutions; discrete components; Enterprise Storage and Communication solutions, security technologies and scalable anti-tamper products; Ethernet solutions; Power-over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi is headquartered in Aliso Viejo, Calif. and has approximately 4,800 employees globally. Learn more at www.microsemi.com.

Microsemi makes no warranty, representation, or guarantee regarding the information contained herein or the suitability of its products and services for any particular purpose, nor does Microsemi assume any liability whatsoever arising out of the application or use of any product or circuit. The products sold hereunder and any other products sold by Microsemi have been subject to limited testing and should not be used in conjunction with mission-critical equipment or applications. Any performance specifications are believed to be reliable but are not verified, and Buyer must conduct and complete all performance and other testing of the products, alone and together with, or installed in, any end-products. Buyer shall not rely on any data and performance specifications or parameters provided by Microsemi. It is the Buyer's responsibility to independently determine suitability of any products and to test and verify the same. The information provided by Microsemi hereunder is provided "as is, where is" and with all faults, and the entire risk associated with such information is entirely with the Buyer. Microsemi does not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other IP rights, whether with regard to such information itself or anything described by such information. Information provided in this document is proprietary to Microsemi, and Microsemi reserves the right to make any changes to the information in this document or to any products and services at any time without notice.